
Cisco Business Edition 6000 H/M インストールガイド、リリース
11.0(1)
初版：2015年 07月 20日

シスコシステムズ合同会社
〒107-6227 東京都港区赤坂9-7-1 ミッドタウン・タワー
http://www.cisco.com/jp
お問い合わせ先：シスココンタクトセンター

0120-092-255 （フリーコール、携帯・PHS含む）
電話受付時間：平日 10:00～12:00、13:00～17:00
http://www.cisco.com/jp/go/contactcenter/



【注意】シスコ製品をご使用になる前に、安全上の注意（ www.cisco.com/jp/go/safety_warning/ ）
をご確認ください。本書は、米国シスコ発行ドキュメントの参考和訳です。リンク情報につきま

しては、日本語版掲載時点で、英語版にアップデートがあり、リンク先のページが移動/変更され
ている場合がありますことをご了承ください。あくまでも参考和訳となりますので、正式な内容

については米国サイトのドキュメントを参照ください。また、契約等の記述については、弊社販

売パートナー、または、弊社担当者にご確認ください。

このマニュアルに記載されている仕様および製品に関する情報は、予告なしに変更されることがあります。このマニュアルに記載されている表現、情報、および推奨

事項は、すべて正確であると考えていますが、明示的であれ黙示的であれ、一切の保証の責任を負わないものとします。このマニュアルに記載されている製品の使用

は、すべてユーザ側の責任になります。

対象製品のソフトウェアライセンスおよび限定保証は、製品に添付された『Information Packet』に記載されています。添付されていない場合には、代理店にご連絡く
ださい。

The Cisco implementation of TCP header compression is an adaptation of a program developed by the University of California, Berkeley (UCB) as part of UCB's public domain version
of the UNIX operating system.All rights reserved.Copyright © 1981, Regents of the University of California.

ここに記載されている他のいかなる保証にもよらず、各社のすべてのマニュアルおよびソフトウェアは、障害も含めて「現状のまま」として提供されます。シスコお

よびこれら各社は、商品性の保証、特定目的への準拠の保証、および権利を侵害しないことに関する保証、あるいは取引過程、使用、取引慣行によって発生する保証

をはじめとする、明示されたまたは黙示された一切の保証の責任を負わないものとします。

いかなる場合においても、シスコおよびその供給者は、このマニュアルの使用または使用できないことによって発生する利益の損失やデータの損傷をはじめとする、

間接的、派生的、偶発的、あるいは特殊な損害について、あらゆる可能性がシスコまたはその供給者に知らされていても、それらに対する責任を一切負わないものと

します。

このマニュアルで使用している IPアドレスおよび電話番号は、実際のアドレスおよび電話番号を示すものではありません。マニュアル内の例、コマンド出力、ネット
ワークトポロジ図、およびその他の図は、説明のみを目的として使用されています。説明の中に実際のアドレスおよび電話番号が使用されていたとしても、それは意

図的なものではなく、偶然の一致によるものです。

Cisco and the Cisco logo are trademarks or registered trademarks of Cisco and/or its affiliates in the U.S. and other countries.To view a list of Cisco trademarks, go to this URL: http://
www.cisco.com/go/trademarks.Third-party trademarks mentioned are the property of their respective owners.The use of the word partner does not imply a partnership
relationship between Cisco and any other company.(1110R)

© 2016 Cisco Systems, Inc. All rights reserved.

http://www.cisco.com/go/trademarks
http://www.cisco.com/go/trademarks


目次

はじめに 1

対象読者 1

サーバインストールドキュメント 2

プラットフォームモデルオプション 3

インストール前 5

はじめる前に 5

インストール前のタスクフロー 5

UCアプリケーションの計画 6

事前設定アプリケーション 6

必要なネットワーク情報の収集 7

インストール 11

インストールの概要 11

データストアにプリロードされているファイルタイプ 11

インストールタスクフロー 12

Cisco Integrated Management Controllerの設定 13

電源オンと CIMCの初期設定 14

CIMC設定の完了 15

ESXi仮想化ハイパーバイザの設定 16

仮想化ハイパーバイザのリモートアクセスのカスタマイズ 16

仮想化ハイパーバイザのアクセスと設定 21

未使用の事前設定 VMの削除 23

仮想マシン OVAの導入 24

Cisco Unity Connection用の VMのカスタマイズ 26

アプリケーション ISOファイルと VMの関連付け 27

ゼロタッチインストールを使用した UCアプリケーションのインストール 28

アンサーファイルの生成 28

仮想フロッピーイメージの作成 29

Cisco Business Edition 6000 H/M インストールガイド、リリース 11.0(1)    
iii



仮想フロッピーイメージのデータストアへのアップロード 30

仮想フロッピーの VMへのマウント 31

ゼロタッチインストールの実行 32

UCアプリケーションの手動インストール 32

パッケージ化された仮想マシン（OVA）のインストールの完了 33

Prime Collaboration Provisioningのインストールの完了 33

Cisco Video Communications Serverのインストールの完了 34

インストール後 37

インストール後のタスクフロー 37

アプリケーションの設定とライセンスの適用 37

アプリケーションのロケールのインストール 39

ロケール ISOと VMの関連付け 39

Unity Connectionのサービスの停止 40

新しいロケールのインストール 40

次の作業 41

Business Edition 6000の NICチーミングの設定 43

NICチーミング 43

NICチーミングの設定 44

スイッチの NICチーミングの設定 44

ESXiの NICチーミングの設定 45

   Cisco Business Edition 6000 H/M インストールガイド、リリース 11.0(1)
iv

目次



第 1 章

はじめに

• 対象読者, 1 ページ

• サーバインストールドキュメント, 2 ページ

• プラットフォームモデルオプション, 3 ページ

対象読者
このガイドは、Cisco Business Edition 6000 H/M Unified Communicationsアプライアンスのインス
トールを予定しているシスコパートナーが使用することを目的としています。このガイドでは、

ソフトウェアをインストールするために必要なタスクについて説明します。

次の表に、使用可能な 3つの注文および展開オプションの概要を示します。要件に一致するオプ
ションを選択してください。

表 1：各展開オプションでのインストールガイドの使用方法

このガイドの使用方法展開オプション

事前設定アプリケーションを使用する場合は、『Pre-configured
Option Reference Guide』で基本的なセットアップの情報を参照
してください。

必要に応じて、このガイドを使用して、追加の UCアプリケー
ションをインストールおよび設定します。

事前設定

ConfigToOrderポータル（CTOP）でサーバを注文した場合は、
コア UCアプリケーションがプレインストールされたサーバが
届きます。

必要に応じて、このガイドを使用して、追加の UCアプリケー
ションをインストールおよび設定します。

Config To Order

このガイドを使用して、インストールをカスタマイズします。カスタマイズ
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サーバインストールドキュメント
次の図は、Cisco Business Edition 6000のインストールのために用意されたドキュメントと、各ド
キュメントがセットアッププロセスにどのように対応するかを示しています。

次のドキュメントを使用できます。

•『Quick Start Guide』：サーバを開梱してラックに設置するときに、このガイドを使用しま
す。

•『Installation Guide for Cisco Business Edition 6000 H/M』：Business Editionサーバに VMware
およびUCアプリケーションソフトウェアをインストールするときに、このガイドを使用し
ます。

•『Pre-configured Option Reference Guide』：UCアプリケーションの事前設定イメージを使用
する場合に、このガイドを使用します。
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プラットフォームモデルオプション
Cisco BE6000プラットフォームは、広範な企業規模とビジネスワークロードを対象にパフォーマ
ンスと密度を優先して設計された、仮想化されたCiscoUnifiedComputing System

™
（CiscoUCS

®
）

製品の上に構築されています。次の 3つのモデルがあります。

• BE6000H：単一の仮想サーバプラットフォームで 9つのコラボレーションアプリケーショ
ンオプションをサポートしています。最大容量は 1000ユーザ、2500デバイス、および 100
コンタクトセンターエージェントです。中規模のエンドツーエンドのコラボレーションの

導入に最適です

• BE6000M：単一の仮想サーバプラットフォームで 5つのコラボレーションアプリケーショ
ンオプションをサポートしています。最大容量は 1000ユーザ、1200デバイス、および 100
コンタクトセンターエージェントです。中規模のエンドツーエンドのコラボレーションの

導入に最適です。

• BE6000S：統合ルータ/ゲートウェイ/仮想化ブレードサーバプラットフォームで 5つの固定
コラボレーションアプリケーションをサポートしています。最大容量は 150ユーザおよび
300デバイスです。小規模の「ボックスオフィス」向けのコラボレーションの導入に最適で
す

Cisco BE6000は、仮想化およびアプリケーションソフトウェアがプリロードされ、コア UCアプ
リケーションが事前設定されたパッケージソリューションです。ビジネスニーズの拡大に応じ

て、追加のコラボレーションアプリケーションをオンにしていきます。

図 1：Cisco BE6000H/M：中規模企業のコラボレーションの導入用に構築
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BE6000Sは、基本的なエントリレベルの音声および IPテレフォニー機能とともに、強力で使い
やすいコラボレーションツールを必要とする小規模サイトに最適です。

図 2：Cisco BE6000S：小規模企業のコラボレーションの導入用に構築
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第 2 章

インストール前

• はじめる前に, 5 ページ

• インストール前のタスクフロー, 5 ページ

はじめる前に
Cisco Business Edition 6000サーバがラックに取り付けられ、電源およびデータネットワークに接
続されている必要があります。手順については、サーバに付属する『Quick Start Guide for Cisco
BusinessEdition』を参照してください。次の場所からコピーをダウンロードすることもできます。

http://www.cisco.com/c/en/us/support/unified-communications/business-edition-6000/
products-installation-guides-list.html

インストール前のタスクフロー
インストールを開始する前に、次のトピックを確認してください。

手順

目的コマンドまたはアクション

インストールするUCアプリケーションを計画
します。

UCアプリケーションの計画, （
6ページ）

ステップ 1   

オプション。事前設定アプリケーションを使用

する場合は、次のトピックを確認してくださ

い。

事前設定アプリケーション, （6
ページ）

ステップ 2   

インストールに必要なネットワークの詳細情報

を収集します。ソフトウェアをインストールす

必要なネットワーク情報の収集,
（7ページ）

ステップ 3   

る場合は、IPアドレスや DNS情報などの情報
が必要です。

Cisco Business Edition 6000 H/M インストールガイド、リリース 11.0(1)    
5

http://www.cisco.com/c/en/us/support/unified-communications/business-edition-6000/products-installation-guides-list.html
http://www.cisco.com/c/en/us/support/unified-communications/business-edition-6000/products-installation-guides-list.html


目的コマンドまたはアクション

UC アプリケーションの計画
インストールを開始する前に、必ずインストールするUCアプリケーションを計画してください。
インストールに使用できる UCアプリケーションと Business Editionコラボレーション導入の設計
方法については、次のサイトを参照してください。

•『Cisco Business Edition 6000 and Cisco Business Edition 7000 Co-residency Policy Requirements』：
このドキュメントは、Cisco Business Edition 6000システムへのインストールに使用できるシ
スコの仮想アプリケーションと、Business Editionサーバでこれらのアプリケーションおよび
サードパーティ製アプリケーションを実行するために満たす必要がある条件について説明し

ます。

http://www.cisco.com/c/en/us/support/unified-communications/business-edition-6000/
products-device-support-tables-list.html

•『Unified Communications in a Virtualized Environment』：このWikiサイトは、シスコの UCア
プリケーションのカタログに関する情報を提供し、展開の設計方法について説明します。

http://www.cisco.com/go/uc-virtualized

•『Preferred Architecture Guides for Midmarket』：推奨アーキテクチャのドキュメントと CVD
ガイドによって、コラボレーションおよび音声導入の規範的なエンドツーエンドのソリュー

ションを提示します。設計概要では、製品の基本知識と推奨アーキテクチャでの各製品の役

割を示します。これには、高レベルのベストプラクティスが含まれます。CVDガイドでは、
推奨アーキテクチャの実装を合理化するのに役立つより詳しい設計と展開の推奨事項を示し

ます。

http://www.cisco.com/c/en/us/solutions/enterprise/design-zone-collaboration/index.html

•『Midmarket Collaboration CVDGuides』：中規模市場向けのCVDでは、Cisco Business Edition
6000上に構築されたコラボレーションソリューションの詳細な設計と段階的な導入に関す
る情報を示します。これらの CVDは、推奨アーキテクチャの中核的な推奨事項に基づいて
おり、場合によっては、追加のソリューション設計を推奨アーキテクチャに対する拡張また

は代替として提案します。

http://www.cisco.com/c/en/us/solutions/enterprise/design-zone-collaboration/index.html

事前設定アプリケーション

システムのセットアップ時間を短縮するため、次のコア UCアプリケーションはサーバにプレイ
ンストールされ、最も一般的な設定で事前設定されています。

• Cisco Unified Communications Manager

• IM and Presence Service
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• Cisco Unity Connection

• Cisco Prime Collaboration Provisioning

• Cisco Paging Server

設定済みの事前設定イメージとそれらが動作するネットワークの詳細については、『Pre-configured
Option Reference Guide』（http://www.cisco.com/c/en/us/support/unified-communications/
business-edition-6000/products-installation-guides-list.html）を参照してください。

必要に応じて、このガイドの手順に従って追加のアプリケーションをインストールできます。

事前設定アプリケーションのいずれかを再インストールする必要がある場合、またはすべてを

新しいバージョンに更新する必要がある場合は、次の場所から仮想マシンイメージをダウン

ロードできます www.cisco.com/go/software

（注）

www.cisco.com/go/software。インストール手順については、ソフトウェアに付属するREADME
ファイルを参照してください。

（注）

必要なネットワーク情報の収集

インストールを開始する前に、ソリューションに必要な次のネットワーク情報を収集します。
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表 2：新規インストールのために収集するネットワーク設定

次の情報を収集します。展開

インストールのために次のネットワーク設定を収集します。

•サブネットマスク

•ゲートウェイ IPアドレス

• VMware Hypervisor ESXiの IPアドレス

• Cisco Integrated Management Controller（CIMC）の IPアドレス

• UCアプリケーションの IPアドレス

• DNSサーバの IPアドレス。

• UCアプリケーションのホスト名

•（任意）ドメイン名

• NTPサーバの IPアドレス

•タイムゾーン

•（任意）SMTPサーバ

検証済みのネットワーク設計については、『Unified
Communications Using Cisco BE6000 Cisco Validated Design
(CVD)』（http://www.cisco.com/c/en/us/solutions/enterprise/
design-zone-collaboration/index.html）を参照してください。

（注）

カスタマイズ

事前設定された展開では、IPアドレッシングと DNS設定に対して事前
設定されたスキームが使用されます。詳細については、『Pre-configured
Option Reference Guide』（http://www.cisco.com/c/en/us/support/
unified-communications/business-edition-6000/
products-installation-guides-list.html）を参照してください。

事前設定されたシステムにアプリケーションを追加する場合は、インス

トールに必要な情報を収集します。次に例を示します。

• UCアプリケーションの IPアドレス

• UCアプリケーションのホスト名

• NTPサーバの IPアドレス

事前設定
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次の情報を収集します。展開

Config ToOrderポータルで発注したサーバについては、元の注文で指定
した設定に従ってネットワークがすでに設定されています。

事前設定されたシステムにアプリケーションを追加する場合は、インス

トールに必要な情報を収集します。次に例を示します。

• UCアプリケーションの IPアドレス

• UCアプリケーションのホスト名

• NTPサーバの IPアドレス

Config To Order
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インストール

• インストールの概要, 11 ページ

• インストールタスクフロー, 12 ページ

インストールの概要
この章では、Business Edition 6000サーバにソフトウェアをインストールするために必要なタスク
について説明します。これには、サーバにソフトウェアをインストールする方法を示す 2つの主
要なタスクフローが含まれます。

カスタマイズされた展開の場合は、この章のタスクを使用して VMwareを設定し、サーバにアプ
リケーションソフトウェアをインストールします。

事前設定された展開の場合と、サーバを Config To Orderポータルで注文した場合は、VMwareお
よび UCアプリケーションがサーバにすでにインストールされています。追加の UCアプリケー
ションをインストールするのに必要なタスクだけを完了してください。

データストアにプリロードされているファイルタイプ

CiscoBusinessEditionサーバは、事前設定された仮想マシンに加えて、指定されたコラボレーショ
ンアプリケーションソフトウェアがデータストアにプリロードされた状態で発送されます。アプ

リケーションインストール用のファイルタイプの内訳を次に示します。

• ISOファイル：ISOファイルは、アプリケーションインストールファイルを含む DVDイ
メージです（たとえば、Bootable_UCSInstall_UCOS_11.0.1.20000-2.sgn.iso）。
UCアプリケーションの ISOファイルは、そのアプリケーションの OVAファイルにアプリ
ケーションソフトウェアが含まれていない場合にのみ存在します。

• OVAファイル：各UCアプリケーションには、仮想マシンをパッケージ化して導入するため
に使用される Open Virtualization Archive（OVA）ファイルがあります。Business Editionサー
バの OVAには 2つのタイプがあります。
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◦一部の OVAは、VMを導入しますが、アプリケーションソフトウェアを含んでいませ
ん。これらのアプリケーションについては、関連する ISOファイルがデータストアに含
まれています（たとえば、cucm_11.0_vmv8_v1.0.ovaと関連する ISOファイル
Bootable_UCSInstall_UCOS_11.0.1.20000-2.sgn.iso）。インストールでは、
OVAテンプレートを導入し、関連する ISOファイルを使用してソフトウェアをインス
トールする必要があります。

◦その他の OVAファイルは、VMを導入し、アプリケーションソフトウェアをインス
トールします（たとえば、cpc-provisioning-11.0.0-815-small.ova）。これら
のアプリケーションについては、ISOファイルがありません。OVAファイルを使用し
て VMを導入し、ソフトウェアをインストールできます。

サーバのデータストアにプリロードされている ISOおよび OVAファイルについては、サーバの
プリロードサマリー（http://www.cisco.com/c/en/us/support/unified-communications/business-edition-6000/
products-release-notes-list.html）を参照してください。

インストールタスクフロー
Cisco Business Edition 6000サーバにソフトウェアをインストールするには、次のタスクを実行し
ます。

手順

目的コマンドまたはアクション

Business Edition 6000サーバの CIMCを設定しま
す。

Cisco Integrated Management
Controllerの設定, （13ページ）

ステップ 1   

BusinessEdition 6000サーバのESXi仮想化ハイパー
バイザホストを設定します。

ESXi仮想化ハイパーバイザの設
定, （16ページ）

ステップ 2   

不要な事前設定 VMを削除します。未使用の事前設定 VMの削除,
（23ページ）

ステップ 3   

ConfigToOrderポータルで注文したサー
バについては、この手順をスキップで

きます。

（注）

インストールする各 UCアプリケーションの仮想
マシン OVAを導入します。

仮想マシン OVAの導入, （24
ページ）

ステップ 4   

Business Edition 6000の展開に Cisco Unity
Connectionが含まれている場合は、UnityConnection
VMをカスタマイズします。

Cisco Unity Connection用の VM
のカスタマイズ, （26ページ）

ステップ 5   

ISOファイルを必要とする UCアプリケーション
をインストールする場合は、ISOファイルをアプ
リケーション VMにマウントします。

アプリケーション ISOファイル
と VMの関連付け, （27ペー
ジ）

ステップ 6   
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目的コマンドまたはアクション

ISOインストールファイルを使用する
アプリケーションのリストについては、

サーバのプリロードサマリーを参照し

てください。

（注）

オプション。ゼロタッチインストールを使用し

て、次のコア UCアプリケーションをインストー
ルします。

ゼロタッチインストールを使用

した UCアプリケーションのイ
ンストール, （28ページ）

ステップ 7   

• Cisco Unified Communications Manager

• IM and Presence Service

• Cisco Unity Connection

• Cisco Unified Contact Center Express

必要な場合は、これらのアプリケーショ

ンに手動インストールを使用すること

もできます。

（注）

残りの UCアプリケーションをインストールする
には、手動のインタラクティブなプロセスを使用

します。

UCアプリケーションの手動イ
ンストール, （32ページ）

ステップ 8   

Cisco Integrated Management Controller の設定
Cisco IntegratedManagementController（CIMC）は、CiscoUCSサーバ用の管理インターフェイスで
す。CIMCはサーバ内で実行し、Webまたは SSHコマンドラインアクセスにより、サーバのリ
モート管理、設定、およびモニタリングを可能にします。

カスタマイズおよび事前設定された展開でBusiness Edition 6000サーバのCIMCを設定するには、
次のタスクを完了します。

Config To Orderポータルでサーバを注文した場合は、CIMCがサーバにすでに設定されていま
す。。

（注）
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手順

目的コマンドまたはアクション

サーバの電源をオンにして、CIMCの基本
的な IPアドレッシングの詳細情報を設定し
ます。

電源オンと CIMCの初期設定, （
14ページ）

ステップ 1   

CIMCインターフェイスのDNSとNTPの設
定を行います。

CIMC設定の完了, （15ページ）ステップ 2   

電源オンと CIMC の初期設定
サーバの電源をオンにして Cisco Integrated Management Controller（CIMC）の基本的な設定を開始
するには、次の手順を使用します。

はじめる前に

『Quick Start Guide』の説明に従って、BE6000サーバがラックに取り付けられ、電源装置に接続
され、データネットワークに接続されていること、およびモニタとキーボードがサーバに接続さ

れていることを確認します。

手順

ステップ 1 電源が接続され、電源ボタン LEDがオレンジ色になっていることを確認します。

ステップ 2 サーバの電源ボタンを押し、ボタンの色がグリーンに変わったことを確認します。

ステップ 3 モニタでブートプロセスを視聴します。

ステップ 4 青いシスコロゴが表示されたら、F8キーを押して CIMC設定ダイアログを表示します。

図 3：CIMC ブート画面で F8 キーを押す

ステップ 5 プロンプトが表示されたら、ユーザ名 adminを入力し、新しいパスワードを作成します。

ステップ 6 CIMC設定画面で、次の詳細情報を入力します。
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• CIMCの IPアドレス

•サブネットマスク

•ゲートウェイ IPアドレス

図 4：CIMC の IP アドレスの詳細情報を入力する

ステップ 7 完了したら、F10キーを押して変更を保存し、システムをブートします。

次の作業

CIMC設定の完了, （15ページ）

CIMC 設定の完了
CIMCインターフェイスの DNSと NTPの設定を行うには、次の手順を使用します。
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手順

ステップ 1 Webブラウザで、CIMCの IPアドレスを入力し、前のタスクで作成したユーザ名 adminとパス

ワードを使用してログインします。

ステップ 2 左側のメニューから [Admin]タブを選択し、[Network]をクリックします。

ステップ 3 メイン画面で、[Network Settings]タブを選択します。

ステップ 4 [Common Properties]で、[Hostname]の設定を CIMCのホスト名に変更します。

ステップ 5 [IPv4 Properties]で、[Preferred DNS Server]を DNSサーバに指定した IPアドレスに変更します。

ステップ 6 メイン画面で、[NTP Settings]タブを選択します。

ステップ 7 [Enable NTP]チェックボックスをオンにします。

ステップ 8 [Server 1]フィールドに NTPサーバの IPアドレスを入力します。

ステップ 9 ページの右下隅にある [Save Changes]を選択します。

ESXi 仮想化ハイパーバイザの設定
ESXi仮想化ハイパーバイザを設定するには、次のタスクを完了します。

手順

目的コマンドまたはアクション

vSphereクライアントを使用したリモート
アクセスを許可するように仮想化ハイパー

バイザをカスタマイズします。

仮想化ハイパーバイザのリモートアク

セスのカスタマイズ, （16ページ）
ステップ 1   

仮想化ハイパーバイザの NTP設定と耐障
害性を設定します。

仮想化ハイパーバイザのアクセスと設

定, （21ページ）
ステップ 2   

仮想化ハイパーバイザのリモートアクセスのカスタマイズ

仮想化ハイパーバイザ（VMware vSphereハイパーバイザ）をカスタマイズして vSphereクライア
ントを使用した PCからのリモートアクセスを有効にするには、次の手順に従います。

Config ToOrderポータルでサーバを注文した場合は、ステップステップ 5にスキップします。（注）
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手順

ステップ 1 ハイパーバイザが起動されると、次の図に示すように、ESXiDirectConsoleのユーザインターフェ
イスがモニタ上に表示されます。

図 5： ESXi のロード後のコンソール画面

ステップ 2 F2キーを押して、次の図に示すような [System Customization]メニューに入ります。
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デフォルトのユーザ名は rootで、パスワードは passwordです。

図 6： ESXi システムカスタマイズメニュー

ステップ 3 [Configure Password]を選択してパスワードを変更します。
アプリケーションが事前設定されている場合は、ステップステップ 5にスキップします。
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ステップ 4 固定 IPアドレスを割り当てるには、[ConfigureManagement Network]メニューを選択し、下図に示
すように、画面の指示に従って “IPの設定”を変更します。

図 7： ESXi ホストへの固定 IP アドレスの割り当て
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ステップ 5 PCをデータネットワークに接続し、新しいハイパーバイザの IPアドレスにアクセスします。下
図に示すようにWebページを確認します。

図 8：ハイパーバイザの Welcome ページ

ステップ 6 vSphereクライアントが PCにインストールされていない場合は、ダウンロードしてインストール
します。

vSphereクライアントは、インターネットからダウンロードするか、またはデータストアでアク
セスできます。
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次の作業

仮想化ハイパーバイザのアクセスと設定, （21ページ）

仮想化ハイパーバイザのアクセスと設定

一部の Business Editionアプリケーションでは、ホストで有効な時間を参照する必要があります。
次の手順に従って、ESXiホストにアクセスして NTPを設定するとともに、NICチーミング機能
を使用してネットワークインターフェイスカード（NIC）の耐障害性を設定し、プレインストー
ルされたアプリケーションを表示し、データストアを参照して事前にロードされたコラボレーショ

ンアプリケーションソフトウェアを確認します。

手順

ステップ 1 vSphereクライアントアプリケーションを起動し、仮想化ハイパーバイザの IPアドレスを入力し
ます。

図 9： vSphere クライアントを使用して仮想化ハイパーバイザにアクセス

ステップ 2 以前に設定したログインクレデンシャルを使用します。

ステップ 3 （任意）BE6000仮想化ハイパーバイザのライセンスは、プレインストールされ、受け取ったとき
には使用できる状態にあります。ライセンスを再適用またはアップグレードする必要がある場合

は、次の手順に従います。

a) ライセンスアップグレードを注文した場合は、注文に付属するドキュメントを参照してライセ
ンスキーを取得します。仮想化ハイパーバイザのライセンスを使用する場合、これはサーバに

同梱されているマスターシリアル番号です。
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マスターシリアル番号は事前にアクティブ化されています。これを登録する必要は

ありません。このシリアル番号は 2 CPUシステム用にハードコード化されていま
す。これを他のライセンスと組み合わせたり、他のライセンスに変更したり、他の

ライセンスで登録したりすることはできません。

（注）

b) [Configuration] > [Software] > [Licensed Features]に移動し、[Edit]をクリックします。
c) [Assign a new license key to this host]を選択します。
d) [Enter Key...]をクリックします。
e) マスターシリアル番号を入力します。
f) [OK]をクリックして、設定ダイアログを閉じ、ライセンスを適用します。

ステップ 4 NTPの設定を行います。
a) [Configuration] > [Software] > [Time Configuration]に移動します。
b) [Properties]をクリックして、[Time Configuration]画面を起動します。
c) 時間を更新します。
d) [Options...]をクリックします。
e) [NTP Settings]を選択します。
f) [Add]をクリックし、NTPサーバの IPアドレスを入力します。複数の NTPサーバを追加する
場合は、このステップを繰り返します。

g) [OK]をクリックします。
h) [General] > [Start and Stop with Host]を選択します。
i) [Start]ボタンをクリックします。[OK]をクリックして [Configuration]画面を閉じます。

ステップ 5 オプション。VMwareの NICチーミング機能を使用して、耐障害性を設定します。
a) [Configuration] > [Hardware] > [Networking]に移動します。
b) 下図に示すように、“Standard Switch: vSwitch0”の [Properties]をクリックします。
c) vSwitch0 Properties設定画面で、[Network Adapters]タブを選択します。
d) データネットワークに接続されている NICを追加するには、[Add…]をクリックします。
e) 対話形式の設定ダイアログに従い、下図に示すように、複数の NICが vSwitch0に追加された
ことを確認したら画面を閉じます。

デフォルトでは、ハイパーバイザで有効な NICは 1つだけで、vmnic0として識別され
ます。

（注）

チーム構成された NICを Ciscoスイッチのチャネルグループに接続する場合は、NIC
チーミングロードバランシングポリシーが [Route based on IP hash]に設定されている
ことを確認します。このポリシーおよびCiscoCollaborationアプリケーションのハイパー
バイザネットワークの他の側面に関する詳細については、付録の Business Edition 6000
の NICチーミングの設定, （43ページ）を参照してください。

（注）

ステップ 6 データストアを参照します。

a) [Configuration] > [Hardware] > [Storage]に移動します。
b) Business Editionサーバのデータストアをリスト表示するには、[Datastore]をクリックします。
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c) datastore1を選択して右クリックし、下図に示すように [Browse Datastore]を選択します。プリ
ロードソフトウェアは /OVA-ISOディレクトリに保存されています。

図 10：プリロードコラボレーション仮想マシンおよびプリロードソフトウェアをデータストアで参照

ステップ 7 （オプション）シスコはOVA-ISOディレクトリをローカルにアーカイブすることを推奨します。
サーバに障害が発生した場合、代替品にはプリロードコンテンツが含まれていません。

次の作業

未使用の事前設定 VMの削除, （23ページ）

未使用の事前設定 VM の削除
事前設定アプリケーションのカスタムインストールが必要な場合は、そのアプリケーションをイ

ンストールする前に、事前設定イメージを削除する必要があります。使用していない事前設定イ

メージを削除するには、次の手順を使用します。

Config ToOrderポータルでサーバを注文した場合は、サーバに事前設定イメージが含まれてい
ないため、この手順をスキップできます。

（注）
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手順

ステップ 1 vSphereクライアントにログインします。

ステップ 2 削除する事前設定仮想マシンを見つけます。

図 11：使用していない事前設定 VM の削除

ステップ 3 VMに緑の三角形が付いている場合は、アイコンを右クリックして [Power] > [Power Off]を選択し
ます。

VMの電源がオフになると、緑色の矢印が消えます。

ステップ 4 VMを右クリックして [Delete From Disk]を選択します。

ステップ 5 削除する仮想マシンごとに、この手順を繰り返します。

次の作業

仮想マシン OVAの導入, （24ページ）

仮想マシン OVA の導入
インストールするアプリケーションごとに、適切な仮想マシン OVAファイルを導入します。

カスタマイズされた展開では、アプリケーションごとに個別の VMを導入する必要があります。
事前設定された展開と Config To Order展開では、追加でインストールするアプリケーション用の
VMのみを導入する必要があります。
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OVAテンプレートファイルは、特定アプリケーションの仮想マシンを定義します。OVAテン
プレートは瞬時に導入されますが、パッケージ化された OVAの導入には時間がかかる場合が
あります。

（注）

図 12： vSphere クライアントに表示された導入済みのアプリケーション VM

手順

ステップ 1 vSphereクライアント上で、[File] > [Deploy OVF Template]に移動します。
[Deploy OVF Template]画面が起動されます。

ステップ 2 PC上でソースの OVAテンプレートファイルを参照し、選択します。アプリケーションとファイ
ル名のマッピングについては、ビルドの概要（http://www.cisco.com/c/en/us/support/
unified-communications/business-edition-6000/products-release-notes-list.html）を参照してください。

ステップ 3 ライセンス契約書に同意するように求められた場合は、引き続き [Next]をクリックします。

ステップ 4 仮想マシンに意味のある名前を指定します。

ステップ 5 導入に適切な仮想マシンのサイズを選択します。

ステップ 6 必要に応じて、残りのパラメータを設定します。

ステップ 7 [Disk Format]を指定するように求められた場合は、[Thick Provision Lazy Zero]を指定します。

ステップ 8 次のタスクに進む前に、すべての UCアプリケーションの VMを導入します。

次の作業

システムに Cisco Unity Connectionが含まれている場合は、次に進みます。 Cisco Unity Connection
用の VMのカスタマイズ, （26ページ）
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それ以外の場合は、次に進みます。アプリケーション ISOファイルとVMの関連付け, （27ペー
ジ）

Cisco Unity Connection 用の VM のカスタマイズ
カスタマイズされたインストールでは、次の手順を使用して、最適なパフォーマンスを確保する

ように Cisco Unity Connection仮想マシンの設定を行います。

Cisco Unity Connectionのカスタマイズされたインストールでは、待ち時間感度の高い VMを導入
し、VMパラメータを設定する必要があります。サーバがBE6000Sの場合は、リソース予約も設
定する必要があります。

事前設定された展開と Config To Orderの展開では、Cisco Unity Connection VMは 1つの仮想 CPU
を使用してボイスメール専用として導入されています。ユニファイドメッセージングまたは統合

メッセージングを使用する場合は、2つ目の CPUを設定する必要があります。

Unity Connectionに 2つの CPUを使用する場合は、他のサポートされるアプリケーションの 1
つを無効にするか、使用しないようにする必要があります。アクティブな仮想マシンの CPU
の合計数が 6個を超えないようにする必要があります。

（注）

手順

ステップ 1 vSphereクライアントの仮想マシンインベントリから、[Unity Connection]エントリを右クリック
し、[Edit Settings]を選択します。

ステップ 2 [Options]タブをクリックします。

ステップ 3 [Advanced] > [General]メニューを選択し、[Configuration Parameters]をクリックします。

ステップ 4 [Add Row]をクリックして、次の詳細情報を入力します。
a) [Name]列に sched.cpu.latencySensitivityと入力します。
b) [Value]列に Highと入力します。

ステップ 5 UnityConnectionのユニファイドメッセージングまたは統合メッセージングを使用する場合は、次
の手順を実行します。

a) [Hardware]タブを選択します。
b) [CPU]メニューを選択し、仮想ソケットの数を 2に設定します。
c) [Resources]タブを選択します。
d) [CPU]メニューを選択し、[Reservation]を 3598MHzに増やします。

次の作業

アプリケーション ISOファイルと VMの関連付け, （27ページ）
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アプリケーション ISO ファイルと VM の関連付け
次のアプリケーションの新しい VMテンプレートを導入した場合は、次の手順を使用して、イン
ストールを完了するために使用する ISOインストールファイルを関連付けます。それ以外の場合
は、インストールタスクに進むことができます。

• Cisco Unified Communications Manager

• IM and Presence Service

• Cisco Unity Connection

• Cisco Unified Contact Center Express

• Cisco Emergency Responder

サーバのインストールファイルの最新のリストについては、次の場所にあるサーバのプリロー

ドサマリーを参照してください。 http://www.cisco.com/c/en/us/support/unified-communications/
business-edition-6000/products-release-notes-list.html

（注）

手順

ステップ 1 vSphereクライアントで、UCアプリケーションの仮想マシンを選択します。

ステップ 2 [Inventory] > [Virtual Machine] > [Edit Settings]を選択します。

ステップ 3 [Hardware]タブで、[CD/DVD Drive]を選択します。

ステップ 4 [Datastore ISO File]を選択します。

ステップ 5 データストアを参照して、アプリケーション ISOファイルを見つけます。

ステップ 6 ファイルを選択して [OK]をクリックします。

ステップ 7 [Device Status]の下で、[Connected and Connect at power on]オプションを有効にします。

ステップ 8 ISOファイルを含むインストール対象のアプリケーションごとに、この手順を繰り返します。

次の作業

次のいずれかの手順を使用して、UCアプリケーションをインストールします。

•ゼロタッチインストールを使用した UCアプリケーションのインストール, （28ページ）

• UCアプリケーションの手動インストール, （32ページ）
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ゼロタッチインストールを使用した UC アプリケーションのインストー
ル

ゼロタッチインストールを使用すると、インストールプロセスの実行中にシステムとやりとりせ

ずに、複数の UCアプリケーションを（必要な場合は複数のホストに）同時にインストールでき
ます。ゼロタッチインストールでは、システムを準備する必要がありますが、特に複数のアプリ

ケーションをインストールする場合に時間を節約できます。インストールするアプリケーション

が 1つまたは 2つだけの場合は、次のセクションに示す手動の手順を実行することもできます。

ゼロタッチインストールを使用して、次のアプリケーションをインストールします。

• Cisco Unified Communications Manager

• IM and Presence Service

• Cisco Unity Connection

• Cisco Unified Contact Center Express

手順

目的コマンドまたはアクション

UCアプリケーションのアンサーファイル
（AFGファイル）を生成します。

アンサーファイルの生成,（28ペー
ジ）

ステップ 1   

AFGファイルを使用して仮想フロッピーイ
メージを作成します。

仮想フロッピーイメージの作成, （
29ページ）

ステップ 2   

仮想フロッピーイメージをデータストアに

アップロードします。

仮想フロッピーイメージのデータス

トアへのアップロード, （30ペー
ジ）

ステップ 3   

個々の仮想フロッピーを対応する UCアプ
リケーション VMにマウントします。

仮想フロッピーの VMへのマウン
ト, （31ページ）

ステップ 4   

UCアプリケーションのゼロタッチインス
トールを実行します。インストールを同時

に実行することを推奨します。

ゼロタッチインストールの実行, （
32ページ）

ステップ 5   

アンサーファイルの生成

UCアプリケーションのゼロタッチインストール用のアンサーファイルを生成するには、次の手
順を使用します。
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ファイルが混在しないように、アプリケーションごとに生成されたファイルを保存するフォル

ダ（たとえば、UCM、IMP、CUC、CCX）を作成することを推奨します。
ヒント

手順

ステップ 1 オンラインのアンサーファイルジェネレータ（http://www.cisco.com/web/cuc_afg/index.html）にア
クセスします。

ステップ 2 [Product]ドロップダウンメニューから、対応するアンサーファイルを生成する UCアプリケー
ションを選択します。

ステップ 3 インストールするバージョンを選択します。

ステップ 4 サーバに設定するインストールの詳細情報を残りのフィールドに入力します。たとえば、パスワー

ド、IPアドレッシング、DNS設定などの項目を割り当てることができます。

ステップ 5 [Generate Answer Files]をクリックして、その UCアプリケーションの platformConfig.xml
ファイルを生成します。

各UCアプリケーションによってplatformConfig.xmlファイルが生成されます。CiscoUnified
Communications Managerでは、clusterConfig.xmlファイルも生成されます。

ステップ 6 次のようにして、生成されたアンサーファイルを保存します。

• Cisco Unified Communications Managerについては、platformConfig.xmlおよび
clusterConfig.xmlファイルを UCMフォルダに保存します。

•その他の UCアプリケーションについては、platformConfig.xmlファイルを対応するア
プリケーションフォルダに保存します。

ステップ 7 ゼロタッチインストールを使用するUCアプリケーションごとに、これらの手順を繰り返します。

次の作業

仮想フロッピーイメージの作成, （29ページ）

仮想フロッピーイメージの作成

アンサーファイルから仮想フロッピーイメージを作成するには、次の手順を使用します。仮想フ

ロッピーイメージはゼロタッチインストールで使用します。

.flpファイルの推奨命名規則に従うことを推奨します。ヒント
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はじめる前に

Winimageを使用して仮想フロッピーイメージを作成できます。Winimageはhttp://www.winimage.com/
download.htmからダウンロードできます。その他のツール（BFIなど）を使用して仮想フロッピー
イメージを作成することもできます。

手順

ステップ 1 Winimageで、[File] > [New]を選択します。

ステップ 2 [Standard format]から [1.44 MB]を選択して [OK]をクリックします。

ステップ 3 UCアプリケーションのplatformConfig.xmlファイルをWinimageウィンドウにドラッグしま
す。

ステップ 4 Winimageにファイルを挿入するように求められたら、[Yes]をクリックします。

ステップ 5 Cisco Unified Communications Managerのみ。clusterConfig.xmlファイルをWinimageウィン
ドウにドラッグします。

ステップ 6 [File] > [Save As]を選択します。

ステップ 7 次の命名規則を使用して、ファイルを仮想フロッピーイメージ（.flpファイル）として保存しま
す。

• Cisco Unified Communications Manager：ucm.flp

• IM and Presence Service：imp.flp

• Cisco Unity Connection：cuc.flp

• Cisco Unified Contact Center Express：ccx.flp

ステップ 8 ゼロタッチインストールを使用する UCアプリケーションごとに、この手順を繰り返します。

次の作業

仮想フロッピーイメージのデータストアへのアップロード, （30ページ）

仮想フロッピーイメージのデータストアへのアップロード

仮想フロッピーイメージをデータストアにアップロードするには、次の手順を使用します。
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手順

ステップ 1 vSphereクライアントを起動します。

ステップ 2 [Configuration]タブを選択します。

ステップ 3 [Storage]を選択します。

ステップ 4 データストアを右クリックして、データストアを参照します。

ステップ 5 アップロード先のディレクトリに移動し、[Upload files to this datastore]アイコンをクリックしま
す。

ステップ 6 vFloppyイメージを AFGフォルダにアップロードします。

ステップ 7 [Upload/Download]警告で、[Yes]をクリックします。

ステップ 8 [Datastore Browser]ウィンドウを閉じます。

次の作業

仮想フロッピーの VMへのマウント, （31ページ）

仮想フロッピーの VM へのマウント
UCアプリケーションの仮想フロッピーイメージを対応する VMにマウントするには、次の手順
を使用します。

手順

ステップ 1 vSphereクライアントで、UCアプリケーションの仮想マシンを選択します。

ステップ 2 [Inventory] > [Virtual Machine] > [Edit Settings]を選択します。

ステップ 3 [Hardware]タブで、[Floppy Drive]を選択します。

ステップ 4 [Use existing floppy image in datastore]を選択します。

ステップ 5 データストアを参照して、仮想フロッピーイメージを見つけます。

ステップ 6 ファイルを選択して [OK]をクリックします。

ステップ 7 [Device Status]の下で、[Connected and Connect at power on]オプションを有効にします。

ステップ 8 ゼロタッチインストールを実行する UCアプリケーションごとに、この手順を繰り返します。

次の作業

ゼロタッチインストールの実行, （32ページ）
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ゼロタッチインストールの実行

仮想フロッピードライブをアプリケーション VMにマウントしたら、ゼロタッチインストール
プロセスを実行します。すべてのゼロタッチインストールを同時に実行することを推奨します。

手順

ステップ 1 VMを右クリックして、[Edit Settings]を選択します。

ステップ 2 [Options]タブをクリックします。

ステップ 3 [Boot Options]で、[Force entry to BIOS]をオンにします。

ステップ 4 [OK]をクリックします。

ステップ 5 vSphereクライアントで、VMを右クリックして [Open Console]を選択します。
コンソールウィンドウが開きます。

ステップ 6 コンソールツールバーの [Power On]アイコンをクリックして、仮想マシンの電源をオンにしま
す。

ステップ 7 BIOS画面が表示されたら、次のブート順序を設定します。
a) CD-ROM
b) Hard Drive
c) Removable Devices
d) ネットワーク

ステップ 8 設定を保存してコンソールを終了します。

UCアプリケーションのインストールがすぐに開始されます。

ステップ 9 インストールする UCアプリケーションごとに、これらの手順を繰り返します。

ステップ 10 インストールが完了したら、仮想マシンから vFloppyの設定を削除します。

次の作業

残りの UCアプリケーションをインストールするには、手動の方法を使用します。

UCアプリケーションの手動インストール, （32ページ）

UC アプリケーションの手動インストール
ゼロタッチインストールオプションがない UCアプリケーション（Cisco Emergency Responderな
ど）をインタラクティブなインストールプロセスに従ってインストールするには、次の手順を使

用します。
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Cisco Prime Collaboration Provisioningまたは Cisco TelePresence Video Communications Serverの
インストールに固有の詳細情報については、次を参照してください。

（注）

• Cisco Video Communications Serverのインストールの完了, （34ページ）

この方法を使用してCisco Unified CommunicationsManagerと IM and Presenceサービスの両方を
インストールする場合は、最初に Unified Communications Managerパブリッシャのインストー
ルを完了する必要があります。

（注）

手順

ステップ 1 vSphere Clientで、インストールするアプリケーションの VMの電源をオンにします。

ステップ 2 VMを右クリックして、[Open Console]を選択します。
コンソールウィンドウが表示されます。

ステップ 3 画面のプロンプトに従って、コンソールからアプリケーションをインストールします。

ステップ 4 手動の方法を使用して Cisco Unified Communications Managerと IM and Presenceサービスの両方を
インストールする場合は、CiscoUnifiedCommunicationsManagerパブリッシャノードのインストー
ルを完了した後で、次の手順を実行します。

a) vSphereコンソールから、Cisco Unified Communications Manager CLIにログインします。
b) set network cluster subscriber dynamic-cluster-configuration 24コマンドを実行します。

c) IM and Presenceまたはサブスクライバ仮想マシンの vSphereコンソールウィンドウを開きま
す。

d) 仮想マシンの電源をオンにします。
e) アプリケーションの設定情報を入力して、インストールを完了します。

ステップ 5 インストールする UCアプリケーションごとに、この手順を繰り返します。

パッケージ化された仮想マシン（OVA）のインストールの完了

Prime Collaboration Provisioning のインストールの完了
Cisco Prime Collaboration Provisioningのインストールを完了するには、次の手順を使用します。
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手順

ステップ 1 vSphereクライアントで、Prime Collaboration Provisioningのために導入する VMを起動します。

ステップ 2 VMを右クリックして、[Open Console]を選択します。
コンソールウィンドウが表示されます。

ステップ 3 ログインプロンプトで、setupと入力します。

ステップ 4 プロンプトで、ネットワーク設定の個々の詳細情報を入力し、Enterを押します。

ステップ 5 インストールモードのプロンプトで、Standard Prime Collaboration Provisioningを表す 1を入力し
ます。

ステップ 6 指示に従ってインストールを完了します。

Cisco Video Communications Server のインストールの完了
Cisco Video Communications Serverのインストールを完了するには、次の手順を使用します。

CiscoVideoCommunicationServerのインストールと設定の詳細については、http://www.cisco.com/
c/en/us/support/unified-communications/telepresence-video-communication-server-vcs/
products-installation-guides-list.htmlを参照してください。

（注）

手順

ステップ 1 仮想マシンの電源をオンにしてコンソールを開きます。

ステップ 2 ログインプロンプトでユーザ名として admin、パスワードとして TANDBERGを入力します。

ステップ 3 実行インストールウィザードのプロンプトで、yを入力して、Enterキーを押します。

ステップ 4 パスワードを変更するには、Yを入力して Enterキーを押します。

ステップ 5 プロンプトで、新しいパスワードを入力して Enterキーを押します。

ステップ 6 次の一連のプロンプトで、次のネットワークの詳細情報を設定します。

• IPプロトコル（デフォルトは IPv4）

• IPアドレス

•サブネットマスク

•デフォルトゲートウェイの IPアドレス
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• LANのイーサネット速度（デフォルトは auto）

ステップ 7 SSH（セキュアシェル）の実行デーモンに対して、Yを入力し、Enterキーを押します。

ステップ 8 すぐに再起動のプロンプトで、yを入力して、Enterキーを押します。

ステップ 9 システムを再起動した後に、WebブラウザでCiscoVideoCommunicationServerにアクセスします。
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第 4 章

インストール後

• インストール後のタスクフロー, 37 ページ

インストール後のタスクフロー

手順

目的コマンドまたはアクション

初回セットアップを実行してUCアプリケー
ションのライセンスを適用するには、次の

手順を実行します。

アプリケーションの設定とライセン

スの適用, （37ページ）
ステップ 1   

オプション。UCアプリケーションの新し
いロケールをインストールします。

アプリケーションのロケールのイン

ストール, （39ページ）
ステップ 2   

インストールが完了したら、次の作業を確

認します。

次の作業, （41ページ）ステップ 3   

アプリケーションの設定とライセンスの適用

この手順は、VMwareライセンスではなくアプリケーションライセンスに適用されます。（注）

各アプリケーションにアクセスし、一部のアプリケーションの初期設定を実行し、ライセンスを

適用するには、次の手順を実行します。
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手順

ステップ 1 個々のアプリケーションの管理ポータルにアクセスするには、アプリケーションの IPアドレスに
移動します。次の情報を考慮します。

•オプション。ページングサーバのインストールの場合：仮想マシンコンソールからアプリ
ケーションURLに関する情報を収集します。デフォルトの初回のユーザ名とパスワードは、
adminと changeMeです。

• Cisco Prime Collaboration Provisioning：IPアドレスに移動し、ユーザ名として globaladminを
使用します。

ステップ 2 アプリケーションのライセンスを購入した後、シスコからメールまたは電子メールで製品認証キー

（PAK）が送信されます。PAKを使用すると、シスコ製品ライセンス登録ポータル（www.cisco.com/
go/license）を使用して特定のインストール用のライセンスキーを生成できます。CiscoPrimeLicense
Managerに直接情報を入力することもできます。

ステップ 3 アプリケーション管理ポータルを使用してライセンスキーを適用します。インストールしたアプ

リケーションに固有のライセンス情報については、次の点を参照してください。

• Prime Collaboration Provisioning：Prime Collaboration Provisioning Standard Editionの使用にライ
センスは不要です。必要に応じて Advanced Editionへのアップグレードを購入できます。

• Paging Server：Basic Paging Serverの使用にライセンスは不要です。必要に応じて Advanced
Editionへのアップグレードを購入できます。

• Unified CommunicationsManager、Cisco Unity Connection、およびCisco Emergency Responder：
Unified Communications Managerの IPアドレスを参照し、[Cisco Prime License Manager]をク
リックします。[License] > [Install License File]を選択し、手順に従います。ライセンスをイン
ストールしたら、UCMパブリッシャVM、UnityConnectionVM、およびEmergencyResponder
VMのアプリケーションインスタンスを追加します。

Cisco Prime License Manager（PLM）は、Cisco Unified Communications Managerおよ
び Cisco Unity Connectionのインストールの一環として自動的にインストールされ
ます。Unified Communications Managerパブリッシャとともにインストールされた
インスタンスだけを使用して、すべてのライセンスを管理します。別のPrimeLicense
Managerインスタンスを使用して、Unified Communications Managerと Unity
Connectionのライセンスを別個に管理しないでください。詳細については、『Cisco
Prime License Manager User Guide』（http://www.cisco.com/c/en/us/support/
cloud-systems-management/prime-license-manager/products-user-guide-list.html）を参照
してください。

（注）

• Cisco VCS、Expressway、TelePresence Server、および Conductorのインストールの場合：ライ
センスの PAKを登録すると、2つのキー（リリースキーとオプションキー）が提供されま
す。管理ポータルで、[Maintenance] > [Option keys]を選択します。最初にリリースキーを適
用し、次にオプションキーを適用します。
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関連トピック

製品ライセンス登録

Cisco Product Upgrade Tool（PUT）

アプリケーションのロケールのインストール

アプリケーション VMのロケールをインストールするには、次のタスクを完了します。

ロケールの詳細については、電話ロケールインストーラのWiki（http://docwiki.cisco.com/wiki/
Cucm-phone-locale-installers）を参照してください。

（注）

手順

目的コマンドまたはアクション

ロケールインストーラを適切な VMに関
連付けます。

ロケール ISOと VMの関連付け, （
39ページ）

ステップ 1   

CiscoUnity Connectionのロケールをインス
トールする場合は、ロケールをインストー

ルする前にサービスを停止します。

Unity Connectionのサービスの停止,
（40ページ）

ステップ 2   

VMにロケールをインストールします。新しいロケールのインストール, （
40ページ）

ステップ 3   

ロケール ISO と VM の関連付け
ロケールインストーラファイルを適切なアプリケーションVMに関連付けるには、次の手順を使
用します。ロケールをインストールする前に、インストーラファイルをVMに関連付ける必要が
あります。
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手順

ステップ 1 vSphereクライアントで、新しいロケールをインストールする VMを選択します。

ステップ 2 [Inventory] > [Virtual Machine] > [Edit Settings]を選択します。

ステップ 3 [Hardware]タブで、[CD/DVD Drive]を選択します。

ステップ 4 データストアのOVA-ISOディレクトリを参照して、適切なロケール ISOファイルを選択します。

ステップ 5 [OK]をクリックします。

ステップ 6 [Device Status]で、[Connected]オプションを有効にします。

ステップ 7 新しいロケールをインストールする VMごとに、この手順を繰り返します。

次の作業

Cisco Unity Connectionのロケールをインストールする場合は、次のセクションに進みます。Unity
Connectionのサービスの停止, （40ページ）

それ以外の場合は、次のセクションに進みます。新しいロケールのインストール, （40ページ）

Unity Connection のサービスの停止
Cisco Unity Connectionの新しいロケールをインストールする場合は、次の手順を使用します。新
しいロケールをインストールする前に、Unity Connection VMで動作しているサービスを停止する
必要があります。

手順

ステップ 1 Cisco Unity Connection Serviceabilityにログインします。

ステップ 2 [Tools] > [Service Management]を選択します。

ステップ 3 次のサービスを停止します。

• Connection Conversation Manager

• Connection Mixer

次の作業

新しいロケールのインストール, （40ページ）

新しいロケールのインストール

Business Editionサーバに UCアプリケーションの新しいロケールをインストールするには、次の
手順を使用します。
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Cisco Unified Communications Managerの場合は、サブスクライバノードのロケールをインス
トールする前に、パブリッシャノードのロケールをインストールしてノードを再起動する必

要があります。

（注）

Cisco Unified Communications Managerと Cisco Unity Connectionのロケールを並行してインス
トールできます。

（注）

手順

ステップ 1 Cisco Unified Communications OSの管理にログインします。

ステップ 2 [Software Upgrades] > [Install/Upgrade]を選択します。 [Software Installation/Upgrade]ウィンドウが
表示されます。

ステップ 3 [Source]ドロップダウンリストボックスから [DVD/CD]を選択します。

ステップ 4 [Next]をクリックします。

ステップ 5 インストールするロケールインストールファイルを選択し、[Next]をクリックします。

ステップ 6 ダウンロードが完了したら、[Next]をクリックします。

ステップ 7 ロケールがインストールされたら、サーバを再起動します。

a) vSphereクライアントにログインします。
b) ロケールをインストールした VMを右クリックして、[Power] > [Restart Guest]を選択します。

次の作業

Cisco Business Edition 6000サーバをインストールした後は、ユーザとデバイスをプロビジョニン
グし、システムの機能を設定できます。プロビジョニングについては、次のガイドを参照してく

ださい。

• Prime Collaboration Provisioning Guide for Cisco Business Edition 6000

http://www.cisco.com/c/en/us/support/unified-communications/business-edition-6000/
products-installation-guides-list.html
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付録 A
Business Edition 6000 の NIC チーミングの設
定

• NICチーミング, 43 ページ

• NICチーミングの設定, 44 ページ

NIC チーミング
ハイパーバイザ NICチーミング機能により、複数の物理アダプタを vSwitchに関連付けて、外部
ネットワークにロードシェアリングおよびフェールオーバー接続を提供することができます。

フェールオーバーとロードバランシング

追加の物理アダプタを vSwitchに割り当てるときに、アクティブまたはスタンバイとして割り当
てることができます。サーバの物理ネットワークへの接続方法に応じて、仮想マシンからのトラ

フィックはアクティブ接続全体で負荷分散することができ、リンク障害が発生したときにスタン

バイアダプタがアクティブになって引き継ぎます。

スイッチドネットワークトポロジ

障害に対する復元力を最大化するため、通常、チーム化されたインターフェイスが別のスイッチ

ング機器に接続されます。これには、シャーシへの別のラインカードの接続、スタックへのスイッ

チの接続、または、完全に独立したデバイスへの接続が含まれることがあります。

独立した物理スイッチを使用する場合、チーム化されたインターフェイスをアクティブに設定し

て、ループを発生させる接続を Ethernetスパニングツリープロトコルでブロックします。リンク
やスイッチに障害が発生した場合は、スパニングツリープロトコルがサーバへの保守可能な接続

を使用するように再収束します。VLANトランキングを使用する場合は、通常、スパニングツ
リープロトコルをVLANごとに設定して、通常動作下のDMZや内部ネットワークトラフィック
に異なる接続を使用します。

IEEE 802.3adリンク集約をサポートする共通論理スイッチ（つまりシャーシまたはクラスタ）に
対して接続した場合は、通常動作下のリンクグループのすべてのアクティブメンバ間のトラフィッ
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クを負荷分散できます。リンク集約は、スパニングツリーよりも迅速にリンク障害に対応でき、

VLANには透過的であるため、専用ネットワークまたはVLANトランク接続に使用される場合が
あります。

次の表に、Business Editionサーバがネットワーク分離と NICチーミングにどのように対応できる
かを示します。

NIC チーミングの設定

手順

目的コマンドまたはアクション

Cisco Catalystスイッチに NICチーミン
グを設定します。

スイッチの NICチーミングの設定, （
44ページ）

ステップ 1   

ハイパーバイザ仮想化ESXiのNICチー
ミングを設定します。

ESXiの NICチーミングの設定, （45
ページ）

ステップ 2   

スイッチの NIC チーミングの設定
サーバインターフェイスを集約する場合は、802.3adリンクアグリゲーションを使用するように
接続先のスイッチポートを設定する必要があります。次の例に、CiscoCatalystスイッチへのVLAN
トランキングを使用してこれをどのように設定するかを示します。

vlan 1
name default
!
vlan 30
name DMZ
!
interface GigabitEthernet1/1
description BE Server Network Interface 1 (Internal/DMZ trunk group)
switchport trunk allowed vlan 1,30
switchport mode trunk
spanning-tree portfast trunk
channel-group 1 mode passive
!
interface GigabitEthernet1/5
description BE Server Network Interface 2 (Internal/DMZ trunk group)
switchport trunk allowed vlan 1,30
switchport mode trunk
spanning-tree portfast trunk
channel-group 1 mode passive
!

サーバインターフェイスを別のスイッチに接続する場合は、標準のトランクポート設定（チャネ

ルグループなし）を使用します。スパニングツリー PortFastは使用しないでください。

vlan 1
name default
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!
vlan 30
name DMZ
!
interface GigabitEthernet1/1
description BE Server Network Interface 1 (Internal/DMZ trunk)
switchport trunk allowed vlan 1,30
switchport mode trunk
!

必要に応じて、スパニングツリーVLANの costコマンドを使用してリンク間でトラフィックを分
散できます。

ESXi の NIC チーミングの設定

手順

ステップ 1 vSphereクライアントにログインします。

ステップ 2 左側のインベントリパネルで、ホストアイコンをクリックします。

ステップ 3 [Configuration]タブで、[Networking]を選択します。

ステップ 4 [Properties]をクリックし、スイッチの設定にアクセスします。

ステップ 5 スイッチに追加する必要がある物理アダプタを選択し、[Next]をクリックします。
マザーボードと PCIカードのネットワークアダプタを組み合わせてチーム化すること
を推奨します。

（注）

ステップ 6 [Move Up]および [Move Down]ボタンを使用して、追加したポートのフェールオーバーポリシー
を調整します。アダプタをフェールオーバーで使用する場合は、そのアダプタを [Active Adapter]
リストから [Standby Adapter]リストに移動します。

ステップ 7 [Next]をクリックします。

ステップ 8 [Finish]をクリックします。
IEEE 802.3adリンクアグリゲーションを設定する必要がない場合は、vSwitchのプロパティペー
ジを閉じて、残りの手順をスキップできます。

ステップ 9 IEEE 802.3リンクアグリゲーションを設定します。
a) [vSwitch0 Properties]ページで、[Ports]タブを選択して vSwitchオブジェクトを編集します。
b) [NIC Teaming]タブを選択します。
c) [Load Balancing]ドロップダウンメニューから、[Route based on IP hash]を選択します。
d) [OK]をクリックします。
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